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ApexSQL® Data Diff 2022.x 

Release Notes 

These release notes provide information about the ApexSQL® Data Diff 2022.x which is a patch release. 

Topics: 

● About ApexSQL Data Diff 

● New features 

● Getting Started 

● System requirements 

● Supported platforms 

● Product licensing 

● Release History 

● About us 

About ApexSQL Data Diff 

ApexSQL Data Diff is a SQL Server data comparison and synchronization tool that detects data differences and 

resolves them without errors. It compares and synchronizes live databases, database backups, and data under 

source control. ApexSQL Data Diff integrates with SQL Server Management Studio and has a command line 

interface, to allow for unattended execution. 

New Features 

This version of ApexSQL Data Diff introduces the following new features, enhancements or deprecations: 

 

Enhancements: 
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 A new warning is added in the Synchronization wizard, alerting the user that the synchronization 

process will fail when synchronizing a table with a unique index and ‘where' clause that only allows 

one record per parent to be the primary record is used 

 Import and Export filter controls are added in the Object filter tab in the New project window 

 New ApexSQL Updater allows users to configure advanced updating settings of all installed 

ApexSQL products 

 Application telemetry now collects anonymous data on the use and performance of applications and 

application components 

Fixes: 

 198861: Tables with data including the leading quotes are not synchronized when a live database is 

the data source and a script folder is the destination data source 

 198438: Data difference view window shows incorrect differences when the data is sorted by a 

column with the ‘int' data type 

 201564: "Unable to cast object of type 'System.DBNull' to type 'System.String'" message is shown 

when comparing two databases while one database has an external data source 

 205993: The actions list in the Summary and warnings step of the Synchronization wizard is 

incorrectly displayed when returning to the Synchronization direction step and updating the 

synchronization direction 

 205992: "There was an error generating the XML document" error is encountered when the editor is 

changed in the Output options tab in the Synchronization wizard 

 199215: Redundant return code 11 error for unsupported edition appears when using CLI 

 198862: The additional objects appear in the script folder and NULL is shown in the Data difference 

view window for the fields when the synchronization is finished while using the live database vs 

script folder 

 198439: The application clientis unresponsive when using mouse scroll in the Data difference view 

window for product version 2019 R2 

 197148: Incorrect link is used when using Help button in the Resources tab 

 193158: "The 'Stub2019' package did not load correctly" error is encountered when the Visual Studio 

2019 is started 

 188883: "The ConnectionString property has not been initialized" message is shown when trying to 

synchronize live database with Git repository 

 188692: Wrong results are shown in the HMTL interactive report when single row is checked 

 188691: Wrong results are shown in the HMTL simple report when single row is checked 

 170335: "Make sure correct username and password are specified" message is shown when Git 

source control password is changed in host and updated in the application connection configuration 

 165269: Custom mapped object pairs are not shown in the Object filter tab of the New project 

window 

https://knowledgebase.apexsql.com/how-to-auto-update-apexsql-tools-add-ins/
https://knowledgebase.apexsql.com/how-to-auto-update-apexsql-tools-add-ins/
https://knowledgebase.apexsql.com/telemetry-in-apexsql-products/
https://knowledgebase.apexsql.com/telemetry-in-apexsql-products/


 

ApexSQL Data Diff 
3 

Release Notes 
 

 165267: Custom schema mapping is not saved after the comparison process is finished, after the Edit 

button is clicked from the Home tab and switched to the Object mapping tab 

 161562: All rows for a compared table are checked in the Data difference view panel, upon refresh 

action is performed after the check-uncheck sequence of events occur 

 163434: Records are not synchronized when a project file is saved from the Object filter tab in the 

New project window and used in the CLI 

 140586: The main application windows disappear in the case when the primary monitor displaying it 

is disconnected while sub-application windows are displayed on a secondary monitor 

 151315: The custom object mapping pairs become unpaired when the Refresh button is clicked under 

the Object mapping tab in the New project window 

 165265: Objects that belong to a schema mapping pair that is removed from the Object mapping 

tab are compared and shown in the Results grid 

 211792: The state of the check box in the main grid and in the data difference view is not consistent 

when uncheck columns in the data difference view 

 211791: "Select for synchronization" message in the Output options tab of Synchronization dialog is 

cut-off when comparing the script folder with path containing more than 40 characters with 

database 

Changes: 

 The activation model is switched to Subscription 

 Error handling and send logs functionality has been modified 

 Trust server certificate option is added under the Connection options dialog 

 The application does not support integration into SQL Server Management Studio 2012, 2014, and 

2016 

 The application does not support integration into Visual Studio 2010, 2012, 2013, and 2015 

 

Getting Started 

 For further information about installation and getting started, please check the Quest Knowledge Base or 

ApexSQL Getting Started. 

System requirements 

Before installing or upgrading Short Product Name Version, ensure that your system meets the following minimum 

hardware and software requirements.  

 

https://knowledgebase.apexsql.com/apexsql-for-mysql-tools-licensing-and-renewals/
https://knowledgebase.apexsql.com/send-logs-feature-in-apexsql-tools/
https://support.quest.com/apexsql-complete/kb
https://www.apexsql.com/getting_started.aspx
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Hardware Dual Core 2.0 GHz CPU 

3 GB memory  

191 MB disk space 

SQL Server SQL Server 2005 and higher [1] 

Azure SQL Database [1] 

Amazon RDS for SQL Server [1] 

Add-in integration Visual Studio 2010 and higher [1] 

 

Server Management Studio 2012 and higher [2] 

OS Windows 7 SP1/Windows Server 2008 R2 SP1 and higher [1] 

Software .NET Framework 4.7.2 or higher 

Note Source control integration available for Azure DevOps [4], Git [5], Mercurial [5], 

Subversion [5] and Perforce [5] 

Permissions and additional 

requirements 

Windows user account with administrative privileges 

 

See Minimum permissions required to install and use ApexSQL products 

 

See Minimum SQL Server permissions for ApexSQL Developer tools 

 

See Remote access for SQL Server instance 

[1] See Supported systems for exact version support 

[2] You can use the latest full-featured backwards compatible SQL Server Management Studio for free. Click here 

[4] Azure DevOps Server (TFS) [5] / Azure DevOps Services 

[5] Up to the latest version 

https://support.microsoft.com/en-us/help/4054530/microsoft-net-framework-4-7-2-offline-installer-for-windows
https://blog.apexsql.com/source-control-support-for-apexsql-products/
https://knowledgebase.apexsql.com/minimum-permissions-required-to-install-apexsql-products/
https://knowledgebase.apexsql.com/minimal-sql-server-permissions-apexsql-developer-tools/
https://knowledgebase.apexsql.com/configure-remote-access-connect-remote-sql-server-instance-apexsql-tools/
https://www.apexsql.com/supported-software.aspx
https://docs.microsoft.com/en-us/sql/ssms/download-sql-server-management-studio-ssms
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Supported platforms 

Windows version 

Windows 7 SP1 & 

Windows Server 2008 

R2 SP1 

Windows Server 2012 

Windows 8.1 & 

Windows Server 2012 

R2 

Windows 10 & 

Windows Server 2016 

Windows Server 

2019 

     

 

SQL Server version [4] 

 2005 2008 2012 2014 2016 

2017 2019 CTP 3 

Windows Linux [3] Windows Linux [3] 

ApexSQL Data 

Diff 

         

 

SQL Server edition [4] 

 Express Standard Enterprise 

Azure SQL Database 

Amazon RDS for 

SQL Server Single Database,  

Elastic Pool 

Managed 

Instance 

ApexSQL Data 

Diff 

      

 

Visual Studio add-in integration 

 2010 2012 2013 2015 2017 2019  

https://www.apexsql.com/sql-tools-datadiff.aspx
https://www.apexsql.com/sql-tools-datadiff.aspx
https://www.apexsql.com/sql-tools-datadiff.aspx
https://www.apexsql.com/sql-tools-datadiff.aspx


 

ApexSQL Data Diff 
6 

Release Notes 
 

ApexSQL Data 

Diff 

      

 

 

SQL Server Management Studio add-in integration 

 2012 2014 2016 17 18  

ApexSQL Data 

Diff 

     

 

 

Source control systems 

 Azure DevOps [6] Git [7] Mercurial [7] Perforce [7] Subversion [7] 

ApexSQL Data 

Diff 

     

 

 [3] Tested on Ubuntu 16.04 

[4] Including Amazon EC2, Google Compute Engine, and Azure Virtual Machine cloud computing SQL Server 

instances 

[6] Azure DevOps Server (TFS) [7] / Azure DevOps Services 

[7] Up to the latest version 

 

Release History (release notes) 

Release: 2022.01.0564 

Date:  March 21, 2022 

Enhancements: 

 A new warning is added in the Synchronization wizard, alerting the user that the synchronization process will 

fail when synchronizing a table with a unique index and ‘where' clause that only allows one record per parent to 

be the primary record is used 

 Import and Export filter controls are added in the Object filter tab in the New project window 

 New ApexSQL Updater allows users to configure advanced updating settings of all installed ApexSQL products 

https://www.apexsql.com/sql-tools-datadiff.aspx
https://www.apexsql.com/sql-tools-datadiff.aspx
https://www.apexsql.com/sql-tools-datadiff.aspx
https://www.apexsql.com/sql-tools-datadiff.aspx
https://www.apexsql.com/sql-tools-datadiff.aspx
https://www.apexsql.com/sql-tools-datadiff.aspx
https://knowledgebase.apexsql.com/how-to-auto-update-apexsql-tools-add-ins/
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 Application telemetry now collects anonymous data on the use and performance of applications and 

application components 

Fixes: 

 198861: Tables with data including the leading quotes are not synchronized when a live database is the data 

source and a script folder is the destination data source 

 198438: Data difference view window shows incorrect differences when the data is sorted by a column with the 

‘int' data type 

 201564: "Unable to cast object of type 'System.DBNull' to type 'System.String'" message is shown when 

comparing two databases while one database has an external data source 

 205993: The actions list in the Summary and warnings step of the Synchronization wizard is incorrectly 

displayed when returning to the Synchronization direction step and updating the synchronization direction 

 205992: "There was an error generating the XML document" error is encountered when the editor is changed in 

the Output options tab in the Synchronization wizard 

 199215: Redundant return code 11 error for unsupported edition appears when using CLI 

 198862: The additional objects appear in the script folder and NULL is shown in the Data difference view 

window for the fields when the synchronization is finished while using the live database vs script folder 

 198439: The application clientis unresponsive when using mouse scroll in the Data difference view window for 

product version 2019 R2 

 197148: Incorrect link is used when using Help button in the Resources tab 

 193158: "The 'Stub2019' package did not load correctly" error is encountered when the Visual Studio 2019 is 

started 

 188883: "The ConnectionString property has not been initialized" message is shown when trying to synchronize 

live database with Git repository 

 188692: Wrong results are shown in the HMTL interactive report when single row is checked 

 188691: Wrong results are shown in the HMTL simple report when single row is checked 

 170335: "Make sure correct username and password are specified" message is shown when Git source control 

password is changed in host and updated in the application connection configuration 

 165269: Custom mapped object pairs are not shown in the Object filter tab of the New project window 

 165267: Custom schema mapping is not saved after the comparison process is finished, after the Edit button is 

clicked from the Home tab and switched to the Object mapping tab 

 161562: All rows for a compared table are checked in the Data difference view panel, upon refresh action is 

performed after the check-uncheck sequence of events occur 

 163434: Records are not synchronized when a project file is saved from the Object filter tab in the New project 

window and used in the CLI 

 140586: The main application windows disappear in the case when the primary monitor displaying it is 

disconnected while sub-application windows are displayed on a secondary monitor 

 151315: The custom object mapping pairs become unpaired when the Refresh button is clicked under the Object 

mapping tab in the New project window 

 165265: Objects that belong to a schema mapping pair that is removed from the Object mapping tab are 

compared and shown in the Results grid 

 211792: The state of the check box in the main grid and in the data difference view is not consistent when 

uncheck columns in the data difference view 

https://knowledgebase.apexsql.com/telemetry-in-apexsql-products/
https://knowledgebase.apexsql.com/telemetry-in-apexsql-products/
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 211791: "Select for synchronization" message in the Output options tab of Synchronization dialog is cut-off 

when comparing the script folder with path containing more than 40 characters with database 

Changes: 

 The activation model is switched to Subscription 

 Error handling and send logs functionality has been modified 

 Trust server certificate option is added under the Connection options dialog 

 The application does not support integration into SQL Server Management Studio 2012, 2014, and 2016 

 The application does not support integration into Visual Studio 2010, 2012, 2013, and 2015 

Release: 2019.03.0535 

Date:  February 02, 2021 

Fixes: 

 199046: "Object reference not set to an instance of an object" error message is shown on SQL Server 

Management Studio startup after the add-in installation 

 194741: "Error 547, Severity 16, Line 7366. The ALTER TABLE statement conflicted with the FOREIGN KEY 

constraint" error is encountered since the Re-enable check constraints with Check option didn’t work after 

the synchronization is finished between two SQL databases 

 188643: Objects under the Object filter tab in the New project window need to be clicked twice on the 

checkbox to be checked or unchecked after all objects were unchecked first 

 189678: Wrong results are shown in the Data Difference View panel for data that contains (a single 

quotation mark) (single quotation marks) when comparing a script folder and a SQL database 

 184173: The SQL Server Management Studio is automatically closed when the application is integrated 

into it 

 

Release: 2019.02.0527 

Date:  April 08, 2020 

Fixes: 

 "Username required" error is encountered when trying to compare databases without permissions to 

access the master database using SQL Server Management Studio 

 "Unable to connect to SQL Server apexsqltesting.database.windows.net. One ore more errors occurred" 

error is encountered when trying to compare databases without permissions to access the master 

database 

 "The destination information is missing or it is incorrect" error is encountered when trying to compare 

databases without permissions to access the master database 

 

Release: 2019.01.0522 

Date:  January 09, 2020 

https://knowledgebase.apexsql.com/apexsql-for-mysql-tools-licensing-and-renewals/
https://knowledgebase.apexsql.com/send-logs-feature-in-apexsql-tools/
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Enhancements: 

 SQL Server 2019 support 

 Temporal tables support 

 SQL graph tables support 

 Pre-comparison quick-check for data differences option is added under the Object filter tab of the New 

project window 

 Play a sound upon finished operation option is added under the General tab of the Options window 

Fixes: 

 "Reloading metadata failed. Invalid URI: The URI is empty" message is shown when running a project file 

which contains the Active Directory - Universal with MFA support authentication 

 The Data compare query window is not shown when a SQL database is right-clicked and the Set as 

source or destination command is used in Visual Studio 

 Authentication type is automatically changed to the Active Directory - Universal with MFA support 

authentication when changing SQL Server 

 "Reloading metadata failed” error is encountered when trying to compare two Git repositories from 

Bitbucket.org 

 "Specified cast is not valid" error is encountered when the filter option for the column is clicked in the 

Data Difference view panel 

 The Save button is not working properly when editing project settings 

 "Execution Timeout Expired. The timeout period elapsed prior to completion of the operation or the 

server is not responding" error is encountered while retrieving row count for the Row filter dialog 

 Backspace key selects text under the condition box of the Filter editor dialog instead of deleting it 

 "Item has already been added" error is encountered when all objects are unmapped under the Object 

mapping tab in the New project window 

 The Synchronization summary in the CLI shows that different records are updated, even though the “d” 

(different) argument is not used in the /records_to_synchronize switch 

 The application add-in is integrated in all SQL Server Management Studio and Visual Studio versions 

through the silent installation even though the /components switch with its values is not specified 

 The application cannot be uninstalled if any version of Visual Studio is running, even though the 

application is not integrated into any VS 

 "Value cannot be null" error is encountered when using the Copy cell value right-click command in the 

Data difference view panel for the Null cell value 

 The application's add-in is integrated automatically in SQL Server Management Studio when installed via 

ApexSQL Installer 

 "Check for update failed. Problem occurred connecting to the ApexSQL server" error is encountered 

when the Get updates button is used from the ApexSQL menu in Visual Studio 2019 

Changes: 

 Dark theme is now used as the default application theme 

 Save as dialogs are now inheriting the application theme 

https://blog.apexsql.com/sql-server-2019-ga-support-for-apexsql-products/
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Release: 2018.07.0386 

Date:  June 21, 2019 

Changes: 

 Software Transaction Agreement is added as a new step in the installation wizard and updated in 

accordance with https://www.quest.com/legal/sta.aspx 

Release: 2018.07.0384 

Date:  June 13, 2019 

Fixes: 

 The application doesn't integrate with SQL Server Management Studio 18 GA version 

 "Object reference not set to an instance of an object" error is encountered when the OK button is clicked 

in the Connection options dialog after changing value for timeout options 

 The application is started in light theme, when the Data comparison is initiated from SQL Server 

Management Studio 

 Check-boxes cannot be checked under the Object filter tab, if the New project window is resized 

 The sort order is not numerical in the Data difference view panel, instead the INT columns are arranged 

by order of only the first digit 

Known limitations: 

 Data sources containing SQL tables without a unique clustered index cannot be compared against 

database backups 

 The Get by label option is not retrieving label state and it uses the latest instead when using Mercurial 

repository 

 

Release: 2018.06.0324 

Date:  February 05, 2019 

Enhancements: 

 SQL Server 2019 CTP 2.0 support 

 SQL Server Management Studio 18 integration support 

 Visual Studio 2019 integration support 

 Active Directory authentication – Universal with MFA support 

 CLI switches: 

o Tables with specified schemas can be filtered via the /include switch: 

"Schemaname.ObjectName" 

o New value for the Synchronization options switch: Ignore pre-processing script failure [ippsf] 

o New value for the compatibility level /cl1 and /cl2 switches: SQL2019 [2019] 

https://www.quest.com/legal/sta.aspx
https://blog.apexsql.com/sql-server-management-studio-ssms-18-support-for-apexsql-tools-add-ins/
https://blog.apexsql.com/visual-studio-2019-preview-support-for-apexsql-tools-add-ins/
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Fixes: 

 "Could not load file or assembly 'Microsoft.SqlServer.Smo" error is encountered when the Browse button 

is clicked for the Use this directory option of the Backup the database before synchronization option in 

the Synchronization wizard 

 The number of rows is not shown in the Rows column of the Object filter when Script folder or Source 

control are used as data sources 

 The Get by label option is not retrieving label state and it uses the latest instead when using Team 

Foundation Server repository 

 Server field is empty on the Destination side under the Data sources tab when the New button is clicked 

in the Project management window 

 Incorrect comparison results are shown when rows are shown as missing and additional, instead of 

different, after the initial comparison key is changed 

 Missing ability to include tables with specified schemas through the CLI using the /include switch 

 Redundant double quotation marks around the application installation path for the generated PowerShell 

script under the Automation script window 

 Redundant double quotation marks and output name are shown in the Automation script window 

 "The specified folder does not contain the appropriate folder structure" message is shown when a 

selected source control project contains the Assemblies folder 

 The set date format yyyyMMdd for the Apply date format option is not applied in the synchronization 

script 

 Filters are not working when any value is entered for specified column in the Results grid 

 Filters are not working when any value is entered for specified column in the Data difference view window 

 Objects cannot be unchecked under the Object filter tab of the New project window when the object list 

is filtered by name or schema 

 The custom object mapping pairs are not checked by default under the Object filter tab for the 

comparison process 

 Memory optimized tables are not synchronized and an error is encountered when the Include transaction 

handling in synchronization script option is checked under the Options tab of the New project window 

Changes: 

 Backup database before synchronization is now unchecked by default 

 Default value for the /backup switch is set to None 

 The application now requires Microsoft .NET framework 4.7.2 

 ApexSQL parent menu of the add-in is now located under the Extensions main menu in Visual Studio 

2019 

Known limitations: 

 Data sources containing SQL tables without a unique clustered index cannot be compared against 

database backups 

 The Get by label option is not retrieving label state and it uses the latest instead when using Mercurial 

repository 
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Release: 2018.05.0244 

Date:  September 06, 2018 

Enhancements: 

 New error handling and send logs functionality 

 Improved application installer with a dark theme 

 New application icon 

 High DPI and 4K resolution support 

 Save automation script as a PowerShell script 

 Visual Studio integration support 

 Active Directory – Password authentication support 

 Active Directory – Integrated authentication support 

 Comparison summary output is added under the Export options in the Home tab 

 Ignore pre-processing script failure option is added under the Synchronization options 

 Additional outputs are added in the Automation script window for: 

o Comparison summary 

o Synchronization actions 

o Synchronization warnings 

o Execution results 

o Synchronization summary 

 CLI switches: 

o Source and destination login for Azure Active Directory authentication [/ad1 and /ad2] 

o Folder mapping settings for source and destination data sources [/fm1 and /fm2] 

o New value for the Synchronization options switch: Ignore pre-processing script failure [ippsf] 

o Name of the executable installer or C# solution package [/pknm] 

Fixes: 

 “Column 'ColumnName' does not belong to table” error is encountered when the custom mapped tables 

and columns are selected in the Results grid to view data differences 

 “Object reference not set to an instance of an object” error is encountered when SQL Server 2005 

database is compared with a SQL Server 2014 database 

 Data source information are not remembered when the Edit button is clicked for the currently compared 

data sources 

 Tables and columns with different names are not shown in the Object filter tab, even though they were 

mapped in the Object mapping tab 

 Project file is shown in the Recent projects list even after the Delete or Remove from list commands were 

used 

 Project file is not shown in the Recycle bin when the Delete right-click command is used in the Project 

management window 

 The /records_to_synchronize switch does not contain any value if all objects are unchecked and the Save 

as batch feature is initiated 

https://knowledgebase.apexsql.com/how-to-send-log-files-from-apexsql-tools/
https://blog.apexsql.com/the-new-apexsql-installer/
https://blog.apexsql.com/apexsql-tool-icons-screenshot-tour/
https://blog.apexsql.com/4k-resolution-and-high-dpi-scaling-support-in-apexsql-tools-add-ins/
https://knowledgebase.apexsql.com/save-project-as-automation-script/
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 Missing the "n" value in the /output_elements switch under the Save as batch window, when none of the 

Output elements options is checked 

 The /on switch is not shown in the Batch script for the C# solution and Executable installer, even though 

the Package name from the Package tab is checked 

 The shortcut (Ctrl + E) for the Edit current project settings command does not work 

 The shortcut (F5) for the Refresh command does not work 

 Missing the Last value for the /backup_set1 and /backup_set2 switch value to choose the last backup set 

 "The type initializer for 'ApexSql.Common.UI.Forms.MetroMessage' threw an exception" error is 

encountered when activating the application through add-in in SQL Server Management Studio 

 Wrong values are specified in the /records_to_synchronize switch when only different/missing/additional 

rows checked 

 "The custom key must contain at least one checked field" message is shown when the Save button is 

clicked after a click on the Reset button in the Customize comparison key 

 The data comparison process cannot be initiated from SQL Server Management Studio when SQL Server 

authentication is used in the Data compare query 

 SQL Server Management Studio stops working when SQL Server instance is not chosen and Database list 

is used from Database drop-down list in Data compare query window 

 SQL Server Management Studio stops working when the Setup button is clicked in the Data compare 

query window to initiate the Source control setup wizard 

 SQL Server Management Studio stops working when SQL Server instance is not chosen and Database list 

is used from Database drop-down list in Data compare query window 

 SQL Server Management Studio stops working when use the Data compare option on a SQL Server 

Analysis Services instance 

 "There is not enough space on the disk" error is encountered while comparing data sources and there is 

no more space on disk 

 "Source control error: Delete failed for 'Item 'ItemName' is obsoleted" error is encountered when trying to 

delete folder in the Subversion source control repository 

 “Reloading metadata failed” error is encountered when comparing data source against a Team 

Foundation Server repository label 

 Release and patch update application error issue when the updating gets canceled on 0% of download, 

and then started again 

 Wrong values are specified in the /records_to_synchronize switch when only different/missing/additional 

rows checked 

 “Cannot connect to '(local)'” error is encountered when there is no default named instance (local) on a 

machine where the application is installed 

 Errors are not shown in the top of the Results window if any is encountered during the synchronization 

process 

 The Results window does not contain information about how much rows is updated/deleted/added to a 

synchronized object(s) when synchronizing to a database 

 The missing rows are wrongly shown in the Additional column in the Comparison summary when using 

the CLI 

 Missing the information about executing Pre and Post processing scripts in the Actions tab 

 "Package executed successfully" message is shown in the Execution results window of an executable 

installer even when the execution is canceled upon first error 



 

ApexSQL Data Diff 
14 

Release Notes 
 

 Missing an information message when mapping newly added objects to the save project in the CLI 

 The copy row values command from the right-click context menu of the Data difference view panel 

pastes inverted row order 

Changes: 

 Save as batch is now Automation script 

Known limitations: 

 Data sources containing SQL tables without a unique clustered index cannot be compared against 

database backups 

 The Get by label option is not retrieving label state and it uses the latest instead when using Mercurial 

repository 

 

Release: 2018.04.0216 

Date:  July 31, 2018 

Fixes: 

 "Could not load file or assembly 'file:///Windows-

Drive:\WINDOWS\Microsoft.Net\assembly\GAC_MSIL\ApexSQL.Engine.Controller'" error is 

encountered when a backup is loaded as a data source in the Data sources tab of the New project 

window 

 "Unknown error has occurred. Please see %AppData%\Local\ApexSQL\ApexSQL 

AppName>\crash.txt" error is encountered when ApexSQL Log or ApexSQL Recover are started while 

ApexSQL Data Diff is installed 

Known limitations: 

 Data sources containing SQL tables without a unique clustered index cannot be compared against 

database backups 

 The Get by label option is not retrieving label state and it uses the latest instead when using Mercurial 

repository 

 Labels cannot be compared for the Team Foundation Server repository 

 

Release: 2018.03.0215 

Date:  June 15, 2018 

Fixes: 

 SQL Server Management Studio stops working when ApexSQL Data Diff 2018 R2 add-in is installed 

alongside ApexSQL Diff 2018 add-in and any Schema compare command is initiated 
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Known limitations: 

 Data sources containing SQL tables without a unique clustered index cannot be compared against 

database backups 

 The Get by label option is not retrieving label state and it uses the latest instead when using Mercurial 

repository 

 Labels cannot be compared for the Team Foundation Server repository 

 

Release: 2018.02.0205 

Date:  January 26, 2018 

Fixes: 

 The add-in icons disappear in SQL Server Management Studio 2012 and 2014 when installed in parallel 

with any other ApexSQL add-in product released after January 22, 2018 

 The application repeatedly asks for the activation key when it is started on an Amazon EC2 instance after 

the virtual machine resources were deallocated and allocated again 

 The silent installer is stopped when the application needs to automatically download and install .NET 

Framework, even when the /verysilent switch is used 

Known limitations: 

 Data sources containing SQL tables without a unique clustered index cannot be compared against 

database backups 

 The Get by label option is not retrieving label state and it uses the latest instead when using Mercurial 

repository 

 Labels cannot be compared for the Team Foundation Server repository 

 

Release: 2018.01.0193 

Date:  December 27, 2017 

Enhancements: 

 High DPI and 4K resolution support 

 Applied concepts of Visual Language Dictionary for Visual Studio for iconography, imagery, colors, 

menus, fonts, formatting and other GUI elements 

 Check/Uncheck all missing/different/additional rows context menu and Home tab options are added for 

SQL tables and views in the Results section 

 Copy row values option is added to the right-click menu in the Data difference panel 

Fixes: 

 "HTML option is already selected as secondary output type. Select another primary output type" message 

is shown even when the Secondary output type is unchecked in the Save as batch window 

https://blog.apexsql.com/4k-resolution-and-high-dpi-scaling-support-in-apexsql-tools-add-ins/
https://blog.apexsql.com/visual-language-dictionary-for-visual-studio-for-iconography-colors-and-other-visual-concepts-applied-in-apexsql-tools-add-ins/
https://blog.apexsql.com/visual-language-dictionary-for-visual-studio-for-iconography-colors-and-other-visual-concepts-applied-in-apexsql-tools-add-ins/
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 The cursor is always back to the beginning of the text box for the Package name option when the tag 

buttons are clicked 

 The warnings output file cannot be created without its dependent switch /synchronize 

 The progress bar for the comparison process is not showing the exact percentage while comparing 

 The /indicate_default_db switch does not contain quotation marks in the Save as batch window 

 Total number of rows is shown in the Comparison process window even when the Row filter is used to 

narrow down the amount of rows 

 The View tab in the Object filter and Object mapping tabs is not shown even though the View option is 

selected in the Options tab of the New project window under the Objects to compare section 

 The Project management window is opened in front of the Update window when new update is available 

 The number of mapped columns is not changed until the selection is changed to another object 

 The number of the columns is not changed in the Object filter for the edited object, but the number of 

columns is changing for other objects, when the Filter editor is applied 

 "Attempt by method" error is encountered when the Refresh button is clicked for branches when the 

Mercurial source control system is chosen 

 SQL Server Management Studio 2016 and 17 stops working when a database backup is loaded in the 

Data compare query window 

 The title and source and destination data sources are not shown in exported reports if none of the 

Header options is checked under the Options tab in the New project window 

 Nothing is shown at the top of the exported report when one or two header options are checked under 

the Options tab in the New project window 

 Tables with text columns are missing in the Results panel and their number is shown as excluded in the 

status bar, even though they are mapped and checked for the comparison, when the Ignore case in the 

text data types option is checked 

 The license file disappears when virtual machine is stopped and then run on Amazon AWS 

 "The selected source control project does not have a corresponding folder structure for tables/views" 

message is shown when the Test or Finish button is clicked for the Perforce source control depot 

 "Make sure that correct username and password are specified" message is shown when specifying local 

folder as repository for the Git source control system, which doesn't require username and password 

 "The selected source control project does not have a corresponding folder structure for tables/views" 

message is shown when the Browse button is clicked to select a project for a Git repository hosted by 

Visual Studio Online 

Known limitations: 

 Data sources containing SQL tables without a unique clustered index cannot be compared against 

database backups 

 The Get by label option is not retrieving label state and it uses the latest instead when using Mercurial 

repository 

 Labels cannot be compared for the Team Foundation Server repository 
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About us 

Quest creates software solutions that make the benefits of new technology real in an increasingly complex IT 

landscape. From database and systems management, to Active Directory and Office 365 management, and cyber 

security resilience, Quest helps customers solve their next IT challenge now. Around the globe, more than 130,000 

companies and 95% of the Fortune 500 count on Quest to deliver proactive management and monitoring for the 

next enterprise initiative, find the next solution for complex Microsoft challenges and stay ahead of the next threat. 

Quest Software. Where next meets now. For more information, visit www.quest.com. 

 

Contacting Quest 

For sales or other inquiries, visit www.quest.com/contact 

Technical Support Resources 

Technical support is available to Quest customers with a valid maintenance contract and customers who have trial 

versions. You can access the Quest Support Portal at https://support.quest.com. 

The Support Portal provides self-help tools you can use to solve problems quickly and independently, 24 hours a 

day, 365 days a year. The Support Portal enables you to: 

● Submit and manage a Service Request 

● View Knowledge Base articles 

● Sign up for product notifications 

● Download software and technical documentation 

● View how-to-videos 

● Engage in community discussions 

● Chat with support engineers online 

● View services to assist you with your product. 

 

 

  

https://www.quest.com/
http://www.quest.com/contact
https://support.quest.com/
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© 2022 Quest Software Inc. 

ALL RIGHTS RESERVED. 

This guide contains proprietary information protected by copyright. The software described in this guide is furnished under a 
software license or nondisclosure agreement. This software may be used or copied only in accordance with the terms of the 
applicable agreement. No part of this guide may be reproduced or transmitted in any form or by any means, electronic or 
mechanical, including photocopying and recording for any purpose other than the purchaser’s personal use without the written 
permission of Quest Software Inc. 

The information in this document is provided in connection with Quest Software products. No license, express or implied, by 
estoppel or otherwise, to any intellectual property right is granted by this document or in connection with the sale of Quest 
Software products. EXCEPT AS SET FORTH IN THE TERMS AND CONDITIONS AS SPECIFIED IN THE LICENSE AGREEMENT FOR 
THIS PRODUCT, QUEST SOFTWARE ASSUMES NO LIABILITY WHATSOEVER AND DISCLAIMS ANY EXPRESS, IMPLIED OR 
STATUTORY WARRANTY RELATING TO ITS PRODUCTS INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTY OF 
MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, OR NON-INFRINGEMENT. IN NO EVENT SHALL QUEST SOFTWARE 
BE LIABLE FOR ANY DIRECT, INDIRECT, CONSEQUENTIAL, PUNITIVE, SPECIAL OR INCIDENTAL DAMAGES (INCLUDING, 
WITHOUT LIMITATION, DAMAGES FOR LOSS OF PROFITS, BUSINESS INTERRUPTION OR LOSS OF INFORMATION) ARISING 
OUT OF THE USE OR INABILITY TO USE THIS DOCUMENT, EVEN IF QUEST SOFTWARE HAS BEEN ADVISED OF THE POSSIBILITY 
OF SUCH DAMAGES. Quest Software makes no representations or warranties with respect to the accuracy or completeness of 
the contents of this document and reserves the right to make changes to specifications and product descriptions at any time 
without notice. Quest Software does not make any commitment to update the information contained in this document. 

If you have any questions regarding your potential use of this material, contact: 

Quest Software Inc. 

Attn: LEGAL Dept 

4 Polaris Way 

Aliso Viejo, CA 92656 

Refer to our Web site (https://www.quest.com) for regional and international office information. 

Patents 

Quest Software is proud of our advanced technology.  Patents and pending patents may apply to this product. For the most 
current information about applicable patents for this product, please visit our website at https://www.quest.com/legal.  

Trademarks 

Quest, the Quest logo, and Join the Innovation are trademarks and registered trademarks of Quest Software Inc. For a complete 
list of Quest marks, visit https://www.quest.com/legal/trademark-information.aspx.  All other trademarks and registered 
trademarks are property of their respective owners. 

Legend 

 CAUTION: A CAUTION icon indicates potential damage to hardware or loss of data if instructions are not followed. 

 

  IMPORTANT, NOTE, TIP, MOBILE, or VIDEO: An information icon indicates supporting information.  

 

https://www.quest.com/
https://www.quest.com/legal
https://www.quest.com/legal/trademark-information.aspx

